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QUICK REFERENCE 

For those who want to dive right into setting up a trusted system, here are the basics for setting up GTD 
with ClearContext Pro: 
 

 
 

Projects: ClearContext allows the assignment of Projects to 
email conversations.  A project is automatically created for 
each Outlook folder.  Use the ClearContext filing buttons to 
file email to Projects.  Use a “/” when creating a Project to 
designate sub-projects (i.e. “Project/Sub-Project”).  
 
Categories = Context: Create Outlook master categories 
starting with “@” (@Phone, @Desk, etc.) to view tasks in the 
Dashboard and Organizer by Context Categories. 
 

 

 
 
 

 

Empty Your Inbox: Use ClearContext workflow buttons (Task, 
Schedule, Delegate, Defer, etc.) to quickly process messages 
in the Inbox.  When creating a Task or Appointment, assign 
context via categories (@Work, @Phone, etc.) for easy 
viewing of context-specific action lists in the Dashboard.  Use 
File Original Message when replying or creating a 
Task/Appointment and ClearContext will automatically file the 
original email to a Project folder. 
 
Next Actions: Right click a task in the ClearContext Dashboard 
or Organizer to mark it as a Next Action.  A category of !Next 
is assigned and a small arrow highlights the Next Action by 
Project. 
 
 

 
 

Review: Use the ClearContext Organizer to review your To-
Do’s by context category, project, next action and/or date.  
Open the organizer from the ClearContext Dashboard or via 
the ClearContext menu. 
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INTRODUCTION 

Many individuals overwhelmed with information take control of Microsoft Outlook by combining 

ClearContext’s flexible and customizable email management features such as inbox prioritization and 

automated categorization with their favorite parts of David Allen’s Getting Things Done methodology to 

create a powerful information management strategy.  Below, we outline basic steps our customers have 

taken to set up ClearContext and Microsoft Outlook to support GTD email processing including creation 

of context-specific action lists, designation of next actions, project categorization, creation and 

maintenance of a “tickler” file, and steps to quickly implement a weekly review.  ClearContext also 

provides email metrics and measurement to help track how well you are handling email.  Use this guide 

to get started – we expect everyone will adjust the system to match their particular information 

processing requirements. 

 

For the purposes of this guide we assume that you have a working knowledge of GTD prior to 

implementation of ClearContext software.  If not, we recommend you visit the Getting Things Done 

website and find some reference materials to get you started.  For an introduction to Getting Things 

Done, see “What is GTD?”  

The process in this whitepaper was developed by ClearContext customers and is the result of real-world 

use of the product.  For detailed discussion on Getting Things Done and ClearContext, see the 

ClearContext discussion forums.  In particular the forum post GTD Users: Start Here contains a collection 

of GTD-related links. 

  

http://www.davidco.com/
http://www.davidco.com/
http://www.davidco.com/what_is_gtd.php
http://www.clearcontext.com/forums/viewtopic.php?t=328
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OVERVIEW 

In his methodology, David Allen suggests categorizing your email by project and context.  Most 

technology solutions address one or the other well, but do not give a comprehensive way of tracking 

both.  Using ClearContext, Projects are assigned to messages, tasks and appointments via the 

ClearContext toolbar and native Outlook categories are used to denote context.  Tasks and 

Appointments can then be viewed by project or context using the Dashboard and the ClearContext 

Organizer. 

WORKFLOW 

ClearContext gives several features to process the Inbox quickly and get it to empty.  Each button below 

can automatically file the original message to an associated project folder and link the item to the 

current message conversation: 

 
 

Task creates an Outlook task from the currently selected message.  Assign an 
Outlook category to this item to maintain action lists. 
 

 
 

Delegate automatically creates either an assigned task or a forwarded 
message with an associated task for quick delegation to another person. 
 

 
 

Schedule creates an appointment from the current message contents. 
 

 
 

Defer places the current message in a deferred folder for a given period of 
time or until a given date.  This is an excellent way to create and maintain a 
“tickler” file. 
 

 
 

Filing buttons (File Msg, Thread or Project) automatically moves messages, 
conversations, or entire projects of email into associated Project Folders.  
Use these buttons to archive reference material that does not require one of 
the actions above. 
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Followup Message allows the creation of a special task tied to a message 
conversation.  When sending an email, create a follow-up to remind you if 
you do not receive a response within a specified amount of time.  If you do 
receive a response, the follow-up task is automatically cancelled. 
 

 

Unsubscribe automatically files current and future messages of a given 
conversation to either their Project folder or an unsubscribed folder.  This 
helps remove those long email threads that you have no interest in that are 
cluttering your Inbox. 

 

REVIEW 

In addition, several ClearContext features provide a view across all messages, tasks, and appointments; 

regardless of location: 

 
 

The Dashboard displays both Project and Context Category views of your 
tasks, providing a control panel for implementation of GTD in ClearContext.  
Switch between Project and Context Category views via the menu at the top 
of the Dashboard. 
 
From the Context Category view, double click a context to quickly jump to 
your action lists (@Work, @Phone, etc.) or a list of all Next Actions. From 
the Project view, pin the projects that are most important to you.  Identify 
Next Actions by Project.  Double click a project name to take notes and 
display all related tasks, appointments, contacts and files.   
 

 
 

Much like the Dashboard, the ClearContext Organizer displays a list of 
global tasks that can be filtered by date, project, category, and/or priority.  
The Organizer is perfect for those who want a more robust way to filter and 
review their task list, providing an efficient vehicle for performing the 
weekly review. 
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ACTION MANAGEMENT 

Following Allen’s advice, the bulk of your email messages (those that you can’t answer in two minutes, 

delete, or file away for reference) will become tasks or appointments in your trusted system.  

ClearContext Pro’s Task, Delegate and Schedule buttons allow you to quickly create tasks and 

appointments from email messages.  Assign Outlook categories to these items to denote context, 

ensuring that they are assigned to the appropriate action list. 

 

  
Category Assignment in Outlook 2007 and Later Category Assignment in Outlook 2003 

 

SETUP 

The first step in setting this up, customize your Outlook Master Categories list to include the action list 

categories you use as you process your Outlook information.  Putting the ‘@” symbol in front of each 

description will ensure that these display at the top of the categories list and appear in the ClearContext 

Dashboard.  We realize that this is a personal list that each user will want to adjust for his/her on 

working style.  Examples of common categories many of our customers have found useful include: 

@Car 

@Delegate 

@Desk 

@Home 

@Internet 

@Phone

 

  



8 Using ClearContext Pro for Microsoft Outlook with Getting Things Done 
© 2011 ClearContext Corporation 
 
ClearContext is a registered trademark of ClearContext Corporation.  GTD and Getting Things Done are 
registered trademarks of David Allen & Company. ClearContext Corporation is not affiliated with David Allen 
& Company in any manner. 

 

To customize the category list in Outlook 2003 

and earlier: 

1. Open a new task or appointment 

2. Click the categories button in the lower 

right hand corner 

3. Click the Master Category list button 

4. Edit the list as desired 

To customize the category list in Outlook 2007 

and later: 

1. Right click the category color field on an 

email, task, or appointment 

2. Select the “All Categories…” menu item 

3. Click New and add a category 

4. Optionally add a color code 

5. Repeat for each category 

 

PROCESSING 

Once this setup is complete, process the inbox using the ClearContext workflow buttons, answering 

those emails that you can, deleting those that you don’t need, filing reference material using 

ClearContext File buttons, and creating tasks or appointments for future work.  As tasks and 

appointments are created, assign a context using Outlook’s native category assignment feature and one 

the categories created above.  This will automatically associate the item with the appropriate action list. 

THE “TICKLER” FILE 

Many GTD’ers follow Mr. Allen’s suggestion of 
creating a “tickler file.”  ClearContext’s Defer 
button is an excellent way to maintain an 
electronic version of this file. The Defer button 
moves an email out of the inbox and schedules it 
as unread at a given time interval or on a given 
date.  
 
When a message is deferred, a dated folder is 
created as a subfolder of the “ClearContext 
Deferred” folder.  Consider these your tickler files.  
Click on any day’s folder to review upcoming items 
or simply wait for the message to re-appear in your Inbox as scheduled. 
For example, say you receive an invite to a corporate networking event on the 25th.  It’s still three weeks 
off and you don’t need to RSVP until the day before.  Click Defer and “schedule” the message for the 
24th.  The message is moved into a subfolder with the month and day you have designated.  You can click 
on this folder at anytime to see all messages pending for that day.  Alternatively, the message 
automatically re-appears in your Inbox, unread, on the 24th, reminding you that you need to make a 
decision about the event. 
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PROJECT DESIGNATION 

ClearContext makes it easy to assign Projects to messages, 

tasks and appointments.  When filing email to a Project folder, 

all messages in that email conversation – past, present and 

future - are automatically associated with the assigned project.  

As you create a Task or Appointment, ClearContext asks for a 

Project assignment.  ClearContext suggests project names for 

those conversations that do not already have a project 

assigned. Press the File button to accept the suggestion or the 

arrow next to it to open the Project Selector and see other 

Project choices. 

File Msg, Thread and Project buttons quickly move email 

messages from the Inbox to automatically created Project 

folders for later reference. In addition, ClearContext can 

automatically save sent messages in these project folders to 

ensure that all project correspondence is properly tagged and 

stored together in one filing system.  Project assignments are automatically carried over to Tasks and 

Appointments generated from email conversation and Projects can be easily assigned to new items as 

they are created.  ClearContext suggests Project assignment based on your email history with the 

current contact. 

The Project Selector (depicted above) allows quick project assignment to messages, tasks and 

appointments.  Select a suggested Project or start typing the Project name and ClearContext will narrow 

your Project list to match your search.  Arrow down to select a Project and assign to the conversation. 

To create multi-level projects, place a “/” between the Main Project heading and the Sub-Project (i.e. 

“Client/Implementation”).  ClearContext will automatically create Project folders that reflect the 

hierarchy (i.e. main folder “Client” with sub-folder “Implementation”). 

SOMEDAY/MAYBE FILE 

If you would like to follow David Allen’s suggestion to maintain a Someday/Maybe file, create a special 
ClearContext Project called “Someday.”  Assign Project “Someday” to ideas that you want to think about 
later.  Click the file button and the message will automatically be placed in a subfolder of your 
ClearContext Project folder.  When you’re ready to review these items, open up the Project folder for 
review. 
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NEXT ACTIONS 

Use the ClearContext Dashboard to quickly identify your Next Actions; those tasks required to keep your 

projects moving forward.   

MARK NEXT ACTION 

After you have processed your Inbox, view the ClearContext 

Dashboard in the Sidebar to see your task list by Project.  If the 

Sidebar isn’t open, open it via the Dashboard button on the 

ClearContext toolbar or ClearContext menu. 

From the Dashboard task list, right click a task to mark it as a Next 

Action.  A small arrow will be added to the left of the task and a 

category of !Next will be added to it. 

REVIEW NEXT ACTIONS BY PROJECT 

Select a Project view from the Summary Dashboard menu (Active in 

the image to the left).  Scan the Project list in the Summary 

Dashboard to view your active Projects.  Those projects with Next 

Actions assigned will have a small arrow next to the total Task count.  

Double-click a project without a Next Action to open it.  Right click 

the next task required to move the project forward and mark it as a 

Next Action.  If none of the tasks listed are an appropriate next 

action, quickly create a new task using the Add Task entry box above 

the Task list. 

 

WORK ON NEXT ACTIONS 

Select a Context Category view from the Summary Dashboard menu 

(Active in the image to the left).  Double-click !Next to open the Next 

Actions Detail Dashboard, showing all tasks designated !Next. This 

allows you to focus on those tasks that are most important to the 

progress of your Projects. 
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REVIEW 

Once the Inbox has been processed, ClearContext provides several methods for reviewing and acting on 

To-Do Lists. 

SUMMARY DASHBOARD 

The Summary Dashboard in the ClearContext Sidebar is the control panel for 

your day.  If you close the Sidebar, access the Dashboard from the button in 

the toolbar or via the ClearContext menu. 

CATEGORIES AND PROJECTS 

The top half of the Dashboard allows you to quickly see which Context 

Categories or Projects require your attention.  Select either a Context 

Category or Project view of tasks via the menu at the top right of the 

Dashboard (Active in the image to the left).  

The Context Category view only displays categories with special characters 

in front of them (i.e. @Phone).  The large count to the left of each category 

indicates the total number of due tasks.  Counts highlighted in red indicate 

categories with overdue tasks.  Double-click to open a list of all tasks for the 

selected category.  Double-click !Next to see all tasks that have been marked 

as Next Actions.  Double-click <Unassigned Tasks> to open the Organizer 

and view a list of all tasks that have not had a category assigned to them. 

When viewing Projects in the Dashboard, large counts to the left of each 

Project give the total number of due tasks, highlighting in red those Projects 

with overdue tasks.  Projects with Next Actions assigned show a small arrow 

next to the Task count. 

Use the pin icon to pin your most important Projects.  To view only pinned Projects, select a view from 

the Project header (Active in the picture to the left).  Double-click <Unassigned Tasks> to view all your 

tasks without Project assignment.  Double-click individual Projects to open a Project Dashboard.  

TASKS/APPTS 

The Tasks and Appointments section of the Summary Dashboard shows all of your Tasks across projects 

and Categories.  Use the filter selector in the header (All in the picture to the left) to filter by date or 

priority.  When ready to focus on a single context (i.e. @Phone) or a single project, open a Detail 

Dashboard. 
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The Due Date and Priority buttons at the bottom of the Dashboard can be used to quickly change task 

information.  Highlight multiple tasks and click the Due Date button to change the date due for all 

selected tasks.  Assign Next Action, Date and Priority by right-clicking a Task. 

 

DETAIL DASHBOARD 

When ready to focus on an individual project or category, open the Detail 

Dashboard by double-clicking a Project or Context Category in the 

Summary Dashboard.   

CATEGORY DETAIL 

When viewing the detail for a Context Category, ClearContext displays all 

tasks and appointments with the current category assigned.  When you’re 

ready to work on a single context/action list (i.e. @Phone), this is the place 

to do it.  As in the Summary Dashboard, right click a task to assign Due 

Date, Start Date, Priority or Next Action. 

PROJECT DETAIL 

In the Project Detail, add project related notes and view all tasks and 

appointments assigned to the Project.  Use the Change menu in the Project 

header to quickly open pinned Projects.  Click Folder to open the associated 

Project folder.  Move or Pin a Project from the Actions menu.  As in the 

Summary Dashboard, right click a task to assign Due Date, Start Date, 

Priority or Next Action. 

FILES AND CONTACTS 

Click the Files tab at the bottom of a Project Dashboard to view all 

attachments that have been emailed for this Project.  Click the Contacts tab 

to view all Contacts you have corresponded with for this Project. 
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CLEARCONTEXT ORGANIZER 

 

Click the Organize Tasks button at the top of the Dashboard to open up the ClearContext Organizer and 

perform the weekly review.  There are four tabs in the Organizer: 

 Dates – view overdue and pending tasks at a glance.  Highlight multiple tasks and use the Due 

Date button to quickly move tasks due dates. 

 Project – see project assignments for all tasks and quickly assign Projects to unassigned tasks. 

 Category – view all tasks by context categories and assign new categories as needed. 

 Review – view completed or pending tasks by week.  Filter by Project or Category.   

As in the Dashboard, Next Actions are designated throughout the Organizer by a small arrow to the left 

of the Task in the priority field.  Right click a task to mark it as a Next Action.  When assigning or filtering 

by category in the Organizer, it will only display categories where the first character is not a letter, for 

example @Phone or !Next. 
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THE WEEKLY REVIEW 

Many GTD users find David Allen’s suggestion of a weekly review to be the most critical component of 
their GTD implementation.  To automate the weekly review with ClearContext, use the ClearContext 
Organizer and ClearContext’s custom Inbox views to process actions by project.  To perform the review, 
use these tools on a weekly basis: 
 

1. Empty the Inbox - Go through the email remaining for the last week – starting with high priority 
email first - and action it using Task, Schedule, Delegate, Defer or Delete. 

2. Empty the Head - Capture new tasks using the quick Add Task function on the Dashboard. 
3. Review - Select Organizer from the ClearContext menu. 

a. Click the Date tab.  Mark items complete as needed and reassign dates in bulk. 
b. On the Project tab, ensure that all tasks have Projects assigned to them.  
c. Also on the Project tab, identify those Projects that do not have a Next Action assigned.  

Either mark an existing task as !Next via right click or add a new task via Add Task at the 
bottom of the Organizer. 

d. Open the Category tab and assign tasks to action lists as required. 
e. Click Review and look at the past week’s completed items to see if further action is 

required and/or document for reference. 
f. View Pending on the Review tab and review tasks and appointments for the upcoming 

week.  Right click and reassign dates as necessary.  Capture any new actions that are 
triggered. Optionally filter by Project or Category for closer scrutiny. 

4. Review the Someday/Maybe folder and transfer any items to your system that have become 
active or delete any items that are no longer relevant. 
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FOR ADVANCED OUTLOOK USERS: CREATING CUSTOM TASK VIEWS THAT INCLUDE THE PROJECT NAME  

The Dashboard and ClearContext Organizer are the quickest ways to view all To Do items, including 

Tasks and Appointments, by Project name. If desired, the Project name can be added to custom task 

views so that tasks within the native Outlook task pane can be sorted by project as well. To add Project 

to a Task view: 

 

1. Go to the task pane and click on the view that you want to alter.  

2. Right click the header on the tasks list (i.e. where it says Subject, Due Date, etc.) and select "Field 

Chooser."  

3. Select "Form..." in the drop down where it says "Frequently Used Fields:" 

4. In the "Select Enterprise forms for this folder" dialog select Application Forms.  

5. Highlight ClearContext and press Add...  

6. Close the current dialog.  

7. In the Field chooser, add CC-TopicName by clicking it and dragging it to the headers you initially 

right clicked.  

8. Exit out of the field chooser. 

9. If desired, change the name of the header on this field by right clicking CC-TopicName, selecting 

Format Columns, and changing the Label. 

10. Repeat for each view that you want to alter.  
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OTHER USEFUL FEATURES 

In addition to the above, ClearContext provides many additional features to help you focus on your most 

important work and manage your email more efficiently. Here are a couple that are of particular interest 

to our GTD customers. 

AUTOFILE 

 

AutoFile speeds up Inbox processing by automatically moving incoming "bacn" email - including 

newsletters, social networking notifications, shopping email, etc. - to categorized folders. 

AutoFile comes pre-configured with filing rules for common senders of automated email. These rules are 

updated over time as ClearContext users identify new senders. Create your own custom AutoFile rules in 

one of two ways: 

1. Highlight a message and press the AutoFile button on the toolbar or select AutoFile from the 

ClearContext menu. In the dialog that appears, choose whether you want to create a sender-

based rule (i.e. bacn@bulksender.net) or a domain-based rule (i.e. bulksender.net) and select 

the group you would like to file to. All messages in the current folder that match your rule will 

be filed to the group you selected.  All future messages from that sender or domain will be filed 

as well. 

2. Click and drag a message onto a filing group in the Sidebar. Select Move on the dialog.  As 

above, all current and future messages from this sender or domain will be moved to the 

AutoFile filing group. 

http://en.wikipedia.org/wiki/Bacn
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PRIORITIZATION 

 

A core feature of ClearContext is the automated prioritization of individual email messages.  Though 

email prioritization is not a core tenet of GTD email processing, ClearContext’s prioritization engine can 

be extremely helpful when trying to get the Inbox down to empty.  When there are too many messages 

to process in the time available, ClearContext’s prioritized view allow you to address your most 

important messages first while saving the less important items for later. 

Priority is determined by the sender of the email and the directness of the email (CC: vs. To:). Designate 

given senders as VIPs and ClearContext will use that information to prioritize the Inbox.  Messages are 

color-coded by priority, with the most important email from the most important senders highlighted in 

red.  In addition, as you process individual emails, manually mark email conversations as important and 

future email in this conversation will also be marked important. 
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MESSAGECONTEXT 

 

The MessageContext is a view of all related items for a given conversation.  For example, your Inbox is 

empty and you receive a new message regarding a meeting you are attending later in the week.  Open 

MessageContext to see previous emails about this meeting, along with any tasks or appointments 

created from the conversation.  In Outlook 2003, access MessageContext via a button on the toolbar. 
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MEASUREMENT AND METRICS 

 

The ClearContext Scorecard provides a way to track your progress implementing GTD.  Click More at the 

bottom of the Dashboard to measure how effectively you are staying on top of your Inbox, response 

time, etc.. 

  



20 Using ClearContext Pro for Microsoft Outlook with Getting Things Done 
© 2011 ClearContext Corporation 
 
ClearContext is a registered trademark of ClearContext Corporation.  GTD and Getting Things Done are 
registered trademarks of David Allen & Company. ClearContext Corporation is not affiliated with David Allen 
& Company in any manner. 

 

ADDITIONAL INFORMATION 

There is a wealth of additional information on the use and optimization of Outlook available on the 

ClearContext Website.  Of particular interest is our ClearContext Daily Workflow, a lightweight process 

for managing email on a daily basis.  All of the above features are documented in more detail in our User 

Guide.  We have created several short tutorials to help learn about the product.  Check out our weblog 

for tips and techniques for getting the most out of ClearContext and/or our User Forums for technical 

questions and features and tips suggestions. 

 

ABOUT CLEARCONTEXT 

ClearContext was founded in 2003 with the goal of building applications to help individuals work more 

effectively with email. The company builds ClearContext for Microsoft Outlook, an add-in to help 

individuals effectively manage their email, tasks, and schedule. 

 

 

 

 

http://www.clearcontext.com/
http://www.clearcontext.com/solutions/
http://www.clearcontext.com/user_guide/
http://www.clearcontext.com/user_guide/
http://www.clearcontext.com/tutorial.html
http://blog.clearcontext.com/
http://online.clearcontext.com/forums/

